
 

Website Management and Editing 
UNC Finance and Operations utilizes the UNC-supported WordPress content management system.  
WordPress is a large-scale system that is used by many websites around the world.  It is widely praised 
for its ease of use in adding and updating content as well as providing the ability to allow management 
by multiple editors. 

One of the core concepts of WordPress is the idea of themes, which define the look and feel of the 
website. All Division sites using UNC WordPress use the Heelium theme, which is a modern theme 
designed for use on multiple web browsers on multiple devices, such as desktop computers, laptops, 
tablets, and phones. 

Resources 
• General WordPress documentation – http://codex.wordpress.org/  
• Heelium – http://heelium.web.unc.edu/ 
• WordPress tutorials (requires Onyen) – http://www.lynda.com/ 
• Questions – foweb@unc.edu  

Basic Terms  
• Page – represents web content that is not time-sensitive. 
• Post – represents web content that is time-sensitive (such as a blog post, news item, or 

announcement).  Posts can be “tagged” or categorized. 
• Media – items that can be added to a page or post other than text, such as photos or 

documents. 
• Shortcode – easy method used by WordPress to add special styling to a page or post. 

Getting Started 
For purposes of this document, all examples will use https://fo.unc.edu/ as the website being managed.  
Substitute the website you are editing as necessary. 

To log in and manage your website, go to https://fo.unc.edu/wp-admin/.  On the screen that appears, 
enter your Onyen and password: 
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After clicking the “Log In” button, you will be redirected to your Dashboard, which shows you all of the 
options available to manage your site.  Note that not all options in the image below may be available to 
you: 



 

The left side of the screen displays various options.  We’ll start with Pages. 

Page Editing 
As mentioned earlier, a Page refers to a portion of web content that is not time-sensitive.  Pages have a 
pre-defined hierarchy or structure and are the traditional method in which information is delivered 
through a web browser. 

To start working with pages, mouse over the Pages option on your Dashboard.  Two options are 
available: All Pages, which shows you a list of pages with details about each page, and Tree View, which 
shows you a hierarchical structure of pages in a brief outline format, or “tree.”  Using Tree View is the 
easiest way to find a page quickly on your site, as shown below: 



  

The view above shows all pages on https://fo.unc.edu/, with several levels of the view expanded to 
show pages that sit underneath others.  To begin editing a page, just click on the title of the page, which 
will change the view to one that looks like the following: 

 

https://fo.unc.edu/


Here, we are editing the “Mailing Instructions” page, as is shown by the page title at the top of the 
screen under the “Edit Page” heading.  Below the “Permalink” for the page is the main editing toolbar 
for this page.  Below the editing toolbar is the content of the page we’re editing.  Let’s take a closer look 
at the editing toolbar: 

   

Notes on the editing toolbar: 

• Both the pulldown menus (File, Edit, Insert, etc.) and the buttons on the toolbar can be used to 
perform the same tasks. 

• To switch between normal and HTML views, click the “Visual” and “Text” buttons, respectively, 
in the upper right. 

• Notice that explicit options for fonts and text sizes are not available.  For consistency, the fonts 
and general text sizes are pre-defined for each website as a whole.  However, it is encouraged to 
use the different headings that are available in the headings drop-down list: 

o Heading 1 should not be used, as that heading is applied to the title of the page, which is 
automatically added at the top of the page. 

o Headings should always be applied in order on a page, as if you were creating an 
outline.  For instance, don’t use Heading 4 before you use Heading 2. 

o The sizes of the headings in the drop-down list may not be an accurate representation 
of how large they are on the published page. 

• The last row of the toolbar contains various “shortcodes” that are available.  Mouse over each 
icon to see what it represents.  A “shortcode” is an easy way in WordPress to visually enhance 
your page.  Examples of some shortcodes are tabs, accordions, and image carousels.  A 
complete list of shortcodes is also available by using the Shortcodes pull-down menu on the first 
row of the editing toolbar. 

Use the editing toolbar the same way you would as if you were working in Microsoft Word – highlight 
the text that you want to change and click the appropriate button on the toolbar.  The shortcodes on 
the bottom row work differently depending on which shortcode you’re using.  The easiest way to use a 
shortcode is to first click on an empty space, and then click on the shortcode that you want.  Shortcodes 
are represented using square brackets, as is shown below: 



 

In this example, a toggle or accordion shortcode has been added into the page.  To finish the toggles, 
either type or cut and paste the appropriate content into the spaces for the title and content as shown 
above.  Though the default number of toggles is four, one may change the number of toggles by either 
removing or adding the appropriate number of lines of content. 

Other shortcodes that are added to a page work in a similar way.  Some shortcode buttons may display a 
pop-up box requesting additional information before the shortcode is inserted into the page, as is 
shown below for a button: 

 

Once you have finished making changes to your page, it needs to be published.  Changes to pages are 
automatically saved as you are making them, which is a great fail-safe in case your computer has 
problems or you accidentally close your web browser.  Let’s take a closer look at the publishing options: 



 

It’s always a good idea to click the Preview Changes button before publishing your page, just to make 
sure the end result is what you were expecting.  You can also change the Status and/or Visibility of a 
page in case it should NOT be visible to everyone at this point in time.  If you want to see the revisions 
that have been made to a page over time (and potentially roll back changes to one of those versions), 
you can do so as well.  Pages can also be set so that they’re published on a future date as well (this is 
more of an option for Posts).  Finally, you can delete a page by moving it to the Trash.   

Once you are satisfied with your page, click the Update button to publish it. 

Post Editing 
As mentioned earlier, a Post refers to a piece of web content that is time-sensitive.  A post is most often 
associated with a blog (or web log), grouped into one or more categories, and can be “tagged” with one 
or more keywords to describe it. 

Editing a post is very similar to editing a page.  To edit a post, click the Posts option from the Dashboard: 



 

All previously entered posts are listed in reverse chronological order from newest to oldest.  This view 
includes the posts’ title, author, categories, tags, comment count (if comments are allowed) and 
publication date.  Click on the title of a post to edit it: 

 

Note that this view is very similar to editing a page – the same editing toolbar and content box is visible 
in the main part of the screen, and the Publish box is visible on the right.  Below the Publish box are 
three additional boxes that are specific to posts: Categories, Tags, and Featured Image: 



The category for a post is a broad area that 
defines the main subject matter or topic for a 
post.  In this example, this post is most 
prominently linked to Facilities Services, so the 
“Facilities” category is used.  More than one 
category can be used for a post if applicable.  Try 
not to use the “Uncategorized” category for a 
post, as this category does not provide any 
direction for visitors to your site who may be 
searching for specific information. 

It may be useful to define one or more tags for a 
post.  Think of a tag as a keyword – a short 
phrase to describe specific content about a post.  
For example, a post on Transportation & Parking 
about employee parking permit signups for the 
next academic year could be tagged with the 
words “parking”, “faculty”, “staff”, “Commuter 
Alternatives Program”, etc. 

The featured image for a post, while not 
required, is a good way to give the reader a visual 
cue as far as what the post is about.  In this 
example, the post title of “Harvesting a New 
Landscape” is a little ambiguous as far as what 
the post itself is about.  The featured image 
clears that up – the woman in the picture with a 
potted plant and the building in the background 
give the reader the idea that there is some sort of 
gardening occurring on campus.  The featured 
image is displayed when viewing a list of all posts 
on a site’s news page or when viewing a list of 
those posts as grouped by category or tag. 

  



Media 
In WordPress, Media refers to images, videos, and other documents (PDF, Word, Excel, PowerPoint, 
etc.) that may be inserted into a page or linked from it.  All these types of files are stored within the 
WordPress website as opposed to linked from an external website.  There are multiple ways to access 
the media for a website: 

 

The “Media” button on the left is part of the Dashboard – clicking on that button goes to the Media 
Library for the entire site.  Clicking the “Add Media” button or going to the Insert menu and choosing 
“Insert/edit link”, “Insert/edit video”, or “Add Media” from a page or post allows one to perform that 
appropriate action from the content that is currently being edited. 

To add a link, highlight the text to be linked, then go to the Insert menu and click on “Insert/edit link”, or 
just click on the same icon on the toolbar: 



   

From this point, you can copy and paste in the desired link in the URL box, or search for the page or post 
at the bottom.  If searching for existing content, click on the title of the content once it has been found, 
and the URL will be filled in automatically.  Click the Add Link button to finish and create your link. 

To add a picture or upload a document to your page or post, click the Add Media button, which will 
bring up a screen like the following: 



 

All previously uploaded pictures, videos, and documents are shown by default.  For large sites, using the 
Search box at the upper right may be useful in finding a previously uploaded file.  Several options are 
shown at the far left for more advanced features, such as creating a photo gallery, setting the featured 
image for a post, or adding a file directly from another website (Insert from URL).  To upload one or 
more files, click the Upload Files tab in the upper left: 



 

You can drag and drop multiple files onto this screen or click the Select Files button to browse your 
computer for the files you wish to upload.  After the new files have been uploaded to the site, they will 
be displayed at the top left of the media library: 

 



The new files are automatically selected to be inserted into the page or post as soon as they are 
uploaded.  You can deselect one or more of these files as you wish.  It is also a good idea to fill in as 
much of the information at the right of the screen under Attachment Details as possible so that others 
viewing these files in the future have some idea as to what these files represent.  Once you have found 
the appropriate file(s) to insert into your page or post, click the Insert into post (page) button in the 
lower right. 

General Editing Notes 
Copying and Pasting 
When pasting text into the editing box, there are times when you may want the formatting of the text to 
be kept, and other times when you may not.  To turn this option on and off, go to the Edit menu and 
choose “Paste as text”: 

 

When the “Paste as text” option is chosen (checked), no formatting will be kept when you paste into the 
editing box.  When the option is not chosen (not checked), general formatting (e.g. bold, italic, 
underline) will be kept when you paste into the box.  Please note that copying and pasting from 
Microsoft Word with this option not checked could cause some unwanted formatting to be left behind 
in the editing box, so be sure to make sure that everything looks as desired. 

Plugins 
WordPress has a series of “Plugins” that allow for advanced features to be used on different websites.  
The available plugins are different from one site to another.  Depending on the site, some plugins may 



be available to be used within a page or post that you may be editing.  Email foweb@unc.edu with any 
questions about a plugin or any feature that may or may not be available. 
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